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Preface

The Sun Management Center 3.5 Update 1 Supplement describes new functionality in the
Sun™ Management Center system management solution.

Note – In this document, the term “x86” refers to the Intel 32–bit family of
microprocessor chips and compatible microprocessor chips made by AMD.

Who Should Use This Book
This book is intended for use by system administrators who have experience working
with networks and understand networking terminology and technology. You should
have a working knowledge of the Sun Management Center application and be familiar
with the documentation for the Sun Management Center 3.5 core product and add-on
products.

How This Book Is Organized
This document describes new functionality in Sun Management Center 3.5 Update 1.
It contains the following chapters:

Chapter 1 provides an overview of the new features available in the Sun Management
Center 3.5 Update 1 product.

Chapter 2 provides information about installation and configuration of the Sun
Management Center 3.5 Update 1 product.
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Chapter 3 describes alternative methods for accessing Java™ Console functions.

Chapter 4 describes enhancements to the Performance Reporting Manager (PRM).

Chapter 5 describes additional enhancements available in the Sun Management Center
3.5 Update 1 product.

Related Books
See the following Sun Management Center 3.5 documents for additional information
about the procedures discussed in this supplement:

� Sun Management Center 3.5 Installation and Configuration Guide
� Sun Management Center 3.5 Performance Reporting Manager User’s Guide

Note – For a complete list of related books, see the Sun Management Center 3.5 Update 1
Release Notes available only online at http://docs.sun.com.

Product Information
Information about this product is available at the Sun Management Center web site at
http://www.sun.com/sunmanagementcenter/.

The Sun Management Center 3.5 Update 1 product includes open source software. To
view license terms, attribution, and copyright statements for the open source software,
see the copyright file located at the following default path:
/cdrom0/image/Webserver/Solaris_9/SUNWtcatr/install/copyright.

Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.
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Ordering Sun Documentation
Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value

To delete a file, type rm
filename.

AaBbCc123 Book titles, new terms, or terms to be
emphasized

Read Chapter 6 in User’s Guide.

These are called class options.

You must be root to do this.

Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the C
shell, Bourne shell, and Korn shell.
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TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #
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CHAPTER 1

New Features in Sun Management
Center 3.5 Update 1

Note – For the latest information on Sun Management Center 3.5 Update 1, see the Sun
Management Center 3.5 Update 1 Release Notes available only online at
http://docs.sun.com.

The Sun Management Center 3.5 Update 1 product has new features in the following
areas:

� “Installation and Configuration” on page 9
� “Enhanced Java Console Navigation” on page 10
� “Performance Reporting Manager (PRM)” on page 10
� “Support for New Hardware Products” on page 10
� “Java Console and Agent Available for Solaris x86 Architecture” on page 11
� “Support for Microsoft Windows XP” on page 11

Installation and Configuration
Sun Management Center 3.5 Update 1 provides several new features related to
installation and configuration:

� Upgrade path from Sun Management Center 3.5 to Sun Management Center 3.5
Update 1

� SNMP encryption (privacy)
� Documentation installation as part of the product installation process
� Ability to specify an operating system as a parameter to the es-makeagent

command
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� Ability to configure agents to use multiple trap destinations by using the
es-trapdest command

� Ability to configure agents to send the registration trap at a custom interval

For more information on these new features, see Chapter 2.

Enhanced Java Console Navigation
The Sun Management Center Java™ Console has been enhanced to provide alternative
methods for accessing Java Console functions. For more information on these
enhancements, see Chapter 3.

Performance Reporting Manager (PRM)
The Performance Reporting Manager (PRM) has been enhanced to provide the
following features:

� New reports for system uptime statistics
� Scheduled reports can be generated in CSV (comma separated values) format
� New graphing options: stacked area charts and stacked bar charts
� Reports can be printed directly from the Java Console

For more information about these new features, see Chapter 4.

Support for New Hardware Products
Sun Management Center 3.5 Update 1 includes support for the following new
platforms and products:

� Sun Fire™ V210, V240, V250, V440, E25K, E20K, E6900, and E4900 systems
� Sun Blade™ 1500, 2500 systems
� PCI+ support for Sun Fire Midrange systems
� UltraSPARC® IV CPU board support for 6800 and 4800 systems
� hPCI+ board and CP2140 system controller for Sun Fire High-End systems

For a list of other supported hardware, see the “Hardware-Specific Module
Availability” in Sun Management Center 3.5 Installation and Configuration Guide.

10 Sun Management Center 3.5 Update 1 Supplement • May 2004



Java Console and Agent Available for
Solaris x86 Architecture
Sun Management Center 3.5 Update 1 supports the Java Console and the agent layer
on Solaris™ x86 architecture. The Solaris x86 support is available on the Solaris 9
release only for the core product and specific add-ons.

The following add-ons are supported on x86:

� Advanced System Monitoring
� Performance Reporting Manager
� Service Availability Manager
� System Reliability Manager

The Java Console on x86 has the same look and feel as the Java Console running on
SPARC™ architecture.

For more information on these features, see Chapter 2.

Support for Microsoft Windows XP
Sun Management Center 3.5 Update 1 now supports Microsoft Windows XP for the
Java Console.

Chapter 1 • New Features in Sun Management Center 3.5 Update 1 11
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CHAPTER 2

Sun Management Center 3.5 Update 1
Installation and Configuration

Sun Management Center 3.5 Update 1 is installed and configured with the same
procedures as Sun Management Center 3.5 except for minor differences for the x86
agent. For information on installing, configuring, or upgrading from previous product
releases, see the Sun Management Center 3.5 Installation and Configuration Guide.

This chapter discusses the following topics that pertain to the installation and
configuration of Sun Management Center 3.5 Update 1:

� “Upgrade Path from 3.5 to 3.5 Update 1” on page 13
� “Supported Platforms, Requirements, and Agent Resource Usage” on page 14
� “Installation and Agent Update for x86” on page 15
� “Documentation Installation” on page 23
� “SNMP Encryption (Privacy)” on page 25
� “Multiple Trap Destinations” on page 27
� “Registration Trap Configuration” on page 29

Upgrade Path from 3.5 to 3.5 Update 1
Upgrading from Sun Management Center 3.5 to Sun Management Center 3.5 is similar
to the upgrading procedure from Sun Management Center 3.0 to Sun Management
Center 3.5. For details on upgrading, see “Upgrading From Sun Management
Center 3.0” in Sun Management Center 3.5 Installation and Configuration Guide.

On an installed, set up, and running Sun Management Center 3.5 host, do the
following:

1. Run es-inst from the 3.5 Update 1 source image.

This uninstalls Sun Management Center 3.5 and asks you whether to preserve the
data.

2. Type y to preserve the data.
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After uninstallation of Sun Management Center 3.5 components, the new packages
for Update 1 are installed. The Installer takes you to setup. The setup detects the
preserved data and asks you whether or not to migrate the data.

3. Type y to migrate the data.

The upgrade procedure is complete.

Supported Platforms, Requirements, and
Agent Resource Usage
This section gives updated information on supported platforms, requirements, and
agent resource usage for Sun Management Center 3.5 Update 1.

Supported Platforms
Sun Management Center 3.5 Update 1 supports the same operating environments as
Sun Management Center 3.5. The following table lists the supported platforms. For
more information, see the Sun Management Center 3.5 Installation and Configuration
Guide.

TABLE 2–1 Supported Platforms

Sun Management Center 3.5 Update 1 Component Operating System

Agent (SPARC) Solaris 2.6, Solaris 7, Solaris 8, Solaris 9
releases

Agent (x86) Solaris 9 release

Server Solaris 8, Solaris 9 releases

Console Solaris 2.6, Solaris 7, Solaris 8, Solaris 9
releases

Microsoft Windows 98, Microsoft Windows
NT SP 4 or later, Microsoft Windows 2000
Professional

JDK Version Requirements
Sun Management Center 3.5 Update 1 requires JDK 1.4.2 for the Sun Management
Center server layer. The JDK 1.4.2 is shipped with Sun Management Center 3.5 Update
1 and can be found on the Sun Management Center 3.5 Update 1 Software CD 1 of 2 in
the directory JDK1.4.2_03.

14 Sun Management Center 3.5 Update 1 Supplement • May 2004



For more information, see the README.html file in the JDK1.4.2_03/Solaris
directory and the “JDK Version Requirements” in the Sun Management Center 3.5
Installation and Configuration Guide.

Agent Resource Usage
The following table gives estimates of the agent CPU and RAM usage by system type
and includes information for the x86 agent.

TABLE 2–2 Agent CPU and RAM Use Estimates by System Type

CPU Usage RAM Usage

Server Type

Heavy or
Light
Configuration Maximum Minimum Average Average Size

Average
Resident Size

Netra X1 Light 4.10% 0.0% 0.05% 10 Mbytes 9 Mbytes

Sun
Enterprise
420R

Light 3.17% 0.0% 0.02% 9 Mbytes 8 Mbytes

Sun Blade
1000

Light 0.38% 0.0% 0.02% 10 Mbytes 9 Mbytes

Sun Blade
100

Heavy 9.16% 0.04% 0.65% 13 Mbytes 12 Mbytes

B100x with
1 CPU at
1533 MHz
(x86)

Light 1.07% 0.06% 0.25% 3 Mbytes 3 Mbytes

Installation and Agent Update for x86
Installing and updating the x86 agent is similar to the SPARC procedures with some
minor differences.

Installing the x86 Agent
You can install the x86 agent by using the command-line installation script, es-inst,
or by using the graphic user interface installer, es-guiinst.
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� To Install the x86 Agent Using the Command-Line
Installation Script
1. Log in as root on the machine where you want to install the x86 agent.

2. In the /etc/nsswitch.conf file, ensure that the group entry has files as the
first token.

group: files nis

3. Review the README file, either /cd-rom-mount-
point/disk1/x86/sbin/README.INSTALL or /cd-image-
dir/disk1/x86/sbin/README.INSTALL.

4. Run the command-line installer at the following location.

� If you are installing from CDs, insert disk 1 and then type:

cd-rom-mount-point/x86/sbin/es-inst
If you are prompted for disk 2, insert disk 2 and then type:

cd-rom-mount-point/x86/image

� If you are installing from a CD image, type:

cd-image-dir/disk1/x86/sbin/es-inst
where cd-image-dir is the directory where you copied the installation CD or
where you downloaded and untarred the installation image from the Web.

5. Follow Steps 5 to 18 in “To Install Using the es-inst Script” in the Sun
Management Center 3.5 Installation and Configuration Guide.

� To Install the x86 Agent Using the GUI
1. Open a terminal window, then type the command xhost + in the terminal

window.

Also, ensure that the DISPLAY environment variable is set to the machine’s display.

2. Log in as root on the machine where you want to install the x86 agent.

3. Make sure that the group entry in the /etc/nsswitch.conf has files as the
first token.

group: files nis

4. Review the README file, either /cd-rom-mount-
point/disk1/x86/sbin/README.INSTALL or /cd-image-
dir/disk1/x86/sbin/README.INSTALL.

5. Run the GUI installer at the following location.

cd-rom-mount-point/x86/sbin/es-guiinst
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If you are prompted for disk 2, insert disk 2 and then type:

cd-rom-mount-point/x86/image

6. Follow Steps 6 to 18 in “To Install Sun Management Center 3.5 on the Solaris
Platform” in the Sun Management Center 3.5 Installation and Configuration Guide as
appropriate.

Using the Agent-Update Image Feature for x86
When you use the agent update feature, you create a single image and apply it to
multiple hosts. You need to create separate update images for SPARC and x86. The
procedures for creating and applying agent-update images varies slightly for x86. For
general information on creating an agent installation and update image, see “Creating
Agent Installation and Update Images” in the Sun Management Center 3.5 Installation
and Configuration Guide.

You can create the agent-update image by using the es-gui-imagetool, which has
a graphical user interface, or by using the es-imagetool, which has a command-line
interface.

� To Create an Agent-Update Image Using
es-gui-imagetool for x86
1. Log in as root on the Sun Management Center 3.5 Update 1 server machine.

2. Run the Sun Management Center 3.5 Update 1 GUI image tool by typing the
following command:

# /opt/SUNWsymon/sbin/es-gui-imagetool

The Welcome screen appears. Click Next. The Overview screen appears, listing the
information that you might need to provide. Click Next.

The Select Update-Image Components screen appears.

3. Select the update-image components.

Four choices are provided:

� Base Agent Packages

� Add-on Agent Packages

� Base and Add-on Agent Packages

� Base and Add-on Agent Patches Only
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Note – Any patches needed for a selected package are automatically included when
you select the package. If you want to install base agent patches and add-on agent
patches only, select Base and Add-on Agent Patches Only.

Select the type of update-image that you want to create, and then click Next. The
Specify the Installation Files Source Directory screen appears.

4. Provide the name of a valid Sun Management Center 3.5 Update 1 source
directory.

The installation source default /cdrom/cdrom0/image is displayed.

� If you are installing from CDs, insert Sun Management Center 3.5 Update 1
Software CD 1 of 2 in the CD-ROM drive.

Enter the following path:

/cd-rom-mount-point/x86/image

� If you are installing from a Sun Management Center 3.5 Update 1 image on
disk, type the path to the disk1/x86 in the Source Directory field. For
example, type:

Source Directory: cd-image-dir/disk1/x86/image

Click Next.

5. Follow Steps 5 to 12 in “To Create an Agent-Update Image Using
es-gui-imagetool” in the Sun Management Center 3.5 Installation and Configuration
Guide as appropriate.

Note – When you are asked to provide a name for the agent update-image, it is
recommended that you use a naming convention that indicates the x86
architecture, for example, x86baseagent.

6. Apply the agent-update image by following “To Install or Update Agents From
an Agent-Update Image Using agent-update-bin for x86” on page 20.

� To Create an Agent-Update Image Using es-imagetool
for x86
1. Log in as root on the Sun Management Center 3.5 Update 1 server machine.

2. Run the Sun Management Center 3.5 Update 1 command-line image tool by
typing the following command:

# /opt/SUNWsymon/sbin/es-imagetool
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3. Select the components to update.

You are prompted to select the components that you want to add to the
update-image, for example:

Select the components you want to add to the update-image.

Do you want to upgrade components of Base Agent? [y|n|q] y
Do you want to install/upgrade components of Addons? [y|n|q] y

Type y to add the component to the update-image, or type n to exclude the
component from the update-image.
You are prompted for a valid source directory.

4. Provide the name of a valid Sun Management Center 3.5 Update 1 source
directory.

� If you are installing from CDs, insert Sun Management Center 3.5 Update 1
Software CD 1 of 2 in the CD-ROM drive and type the path to the Sun
Management Center 3.5 Update 1 installation directory for x86.

Enter a valid source directory: /cdrom-mount-point/x86/image

� If you are installing from a Sun Management Center 3.5 Update 1 image on
disk, type the path to the image disk1/x86/image directory. Type:

Enter a valid source directory: /cd-image-dir/disk1/x86/image

5. Follow Steps 5 to 9 in “To Create an Agent-Update Image Using es-imagetool” in
the Sun Management Center 3.5 Installation and Configuration Guide as appropriate.

Note – When you are asked to provide a name for the agent update-image, it is
recommended you use a naming convention that includes the x86 architecture. For
example, type x86baseagent.

6. Apply the agent-update image by following “To Install or Update Agents From
an Agent-Update Image Using agent-update-bin for x86” on page 20.

Note – Because Sun Management Center 3.5 Update 1 is the first version to have the
x86 agent, you can update agents initially by using the agent-update.bin method
only. For incremental add-on installations of agents, you can use the manage jobs
tasks, described in “To Install Agents From an Agent-Update Image Using the Manage
Jobs Task” in the Sun Management Center 3.5 Installation and Configuration Guide.
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� To Install or Update Agents From an Agent-Update Image
Using agent-update-bin for x86
1. Log in as root on the Sun Management Center 3.5 Update 1 server machine.

2. Create an agent-update image using either of the image tools.

� To create an agent-update image using es-gui-imagetool, follow the
instructions in “To Create an Agent-Update Image Using es-gui-imagetool
for x86” on page 17.

� To create an agent-update image using es-imagetool, follow the instructions
in “To Create an Agent-Update Image Using es-imagetool for x86”
on page 18.

3. Download the appropriate agent-update.bin from the Sun Management
Center server to each target machine’s root directory.

� For x86 agents, the file is found in /opt/SUNWsymon/base/bin/i386-sun-
solaris/agent-update.bin.

� For SPARC agents, the file is found in /opt/SUNWsymon/base/bin/sparc-
sun-solaris/agent-update.bin.

4. Log in as root on the target machine.

5. Go to the directory where you downloaded agent-update.bin.

6. Type ./agent-update.bin -s server -r http-port -p image-name, where

� server is the server that you logged into in Step 1.
� http-port is the Sun Management Center 3.5 Update 1 Web server port.
� image-name is the name of the agent-only image you created in Step 2.
For example, assume that the Sun Management Center 3.5 Update 1 server name is
Production1 and that the Web server port is 8080. Also, assume that the
agent-update image name is x86baseagent. You would then type:

# ./agent-update.bin -s Production1 -r 8080 -p x86baseagent

7. Provide the security seed and the SNMPv1 community string.

The agent-update process prompts you for the security seed and the SNMPv1
community string.

� The security seed must be the same seed that you provided when you set up
the Sun Management Center 3.5 Update 1 server and agent.

� The SNMPv1 community string must be the same community string you
provided when you set up the Sun Management Center 3.5 Update 1 server and
agent.

The update process applies the update to the machine without prompting for
further information.
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When the update process completes, check the update status by viewing the log
file /var/opt/SUNWsymon/log/agent-update.log on the target machine.

� To Create an Agent-Only Installation Image Using
es-makeagent for x86
1. Log in as root.

2. Put the Sun Management Center 3.5 Update 1 Software CD 1 of 2 in the
CD-ROM drive.

3. Type the command /opt/SUNWsymon/sbin/es-makeagent.

You are prompted for the installation source files directory.

4. Type the source directory.

If you are installing from CD-ROM, type:

cdrom-mount-point/x86/image

If you are installing from a CD image, type:

cdrom-image-dir/x86/image

5. Type the name of the target directory.

If the directory does not exist, you are asked whether you want to create it. Type y
to create the directory, or type n or q to exit to the system prompt.

The directory you specify must have write permission for root.

For example:

# enter the target directory: /es-makeagent-image
Directory /es-makeagent-image does not exist

Do you want to create it (y|n|q) y

The es-makeagent script creates the subdirectories disk1 and disk2 in the
directory you specified, and then copies the files required to the subdirectories.

When es-makeagent completes copying files from Sun Management Center 3.5
Update 1 Software CD 1 of 2, the CD is ejected, and you are prompted to insert the
second CD or specify the source directory for disk 2.

a. Remove the first Sun Management Center 3.5 Update 1 installation CD.

Place the Sun Management Center 3.5 Update 1 CD 2 of 2 in the CD-ROM
drive, then close the drive.

b. When the CD-ROM drive LED turns off, press Return.

es-makeagent copies the remaining files from the CD.

You are informed that the agent-only product is available in the directory you
specified. The command required to install the agent on the local machine is
also displayed.
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Tip – Mount the target directory using NFS, so that the directory is accessible by
other machines on your network.

6. Type the command eject to eject the CD.

You can now install the Sun Management Center 3.5 Update 1 x86 agent using any
of the following methods.

� Use the es-inst -a command. When prompted for the installation source
directory, provide the name of the agent-only installation image that you
specified. Make sure that you have shared the agent-only installation image by
using Network File Sharing.

� Apply the agent-only installation image using the JumpStart software.

Note – The agent-only installation image also contains a tar file that you can ftp to
other agent machines and uncompress on each agent machine to create an
installation image. The uncompressed installation image directory contains the
subdirectories disk1 and disk2. To install from the uncompressed image on each
agent machine, change directory to the disk1/sbin directory, and use the
es-inst command.

Limitations to the x86 Agent
The Solaris x86 agents do not support any hardware-specific add-ons. The x86 agents
have modules under the Operating System, Local Applications, and Remote Systems
categories of the Module Browser tab in the Host Details window. Features such as
Physical View, Logical View, Hardware Diagnostic module, and the Config Reader
module are not yet available on the Solaris x86 platform.

In the Java Console window, all x86 platforms have the same x86 icon. For example,
two different x86 platform machines, such as the LX50 and the VX60, would both have
the same icon.

You can filter by platform type when you use the Discovery feature, the Manage Jobs
feature, or the PRM add-on. You can filter for the x86 platform by selecting x86 as the
platform option.

For the Performance Reporting Manager (PRM) add-on, no system reports and
hardware configuration reports are available.
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Documentation Installation
Sun Management Center 3.5 Update 1 gives you the option of installing the product
documentation packages (SUNWpsmd and SUNWsmd) during product installation. Both
the GUI and command line installation ask you to specify whether you want the
documentation to be installed into your own environment. Online help for is always
installed with the product.

In addition, you can directly view the documentation in HTML or PDF from the Sun
Management Center 3.5 Update 1 Software CD 2 of 2.

� To Install the Documentation Using pkgadd
1. Log in as superuser (su) on the machine on which you want to install the

documentation packages.

This machine might be a documentation server or an administrative console.

2. Ensure that the SUNWsdocs package is already installed by typing:

# pkginfo | grep SUNWsdocs

If the package is installed, the system shows:

application SUNWsdocs

3. Insert the Software CD 2 of 2 CD into the CD-ROM drive.

The Volume Manager (vold) should mount the media automatically.

4. Change to the following directory:

# cd /cdrom/cdrom0/image/PE/CommonForSolaris/Basic

5. Install the packages by typing the following command:

# pkgadd -d .

where -d means from the device and the period (.) means to install from the
current directory.

6. Select the documentation collections that you want to install from the list.

All is the default.
The documentation is installed in /var/opt/sun_docs/sundocs.html.

7. (Optional) View the documentation by opening
/var/opt/sun_docs/sundocs.html in your web browser.
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� To Install the Documentation During Product
Installation
1. Follow the directions in the Sun Management Center 3.5 Installation and

Configuration Guide.

For directions on using the graphical user interface installation es-guiinst, see
Chapter 6.
For directions on using the command line installation es-inst, see Appendix B.

2. After you select a language during installation, type y at the prompt that asks
whether to install the product documentation:

3. (Optional) View the product documentation by opening
/var/opt/sun_docs/sundocs.html in your web browser.

� To View Documentation Directly From the Media
1. Launch your browser.

2. Insert Sun Management Center 3.5 Update 1 Software CD 2 of 2.

3. Open the file by choosing the appropriate Open command from the File menu
and typing:

cdrom-mount-point/image/index.html

4. At “Sun Management Center 3.5 Update 1 Software Collection,” select the
appropriate language and format for the documentation.

Note – Even though online help and other documentation were not revised for this
release and are labeled for Sun Management Center 3.5, they still apply to the product.
For documentation issues for the Sun Management Center 3.5 Update 1 collection, see
the appropriate release notes and supplements and the Sun Management Center 3.5
Update 1 Release Notes.
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es-makeagent Operating System
Selection
When creating an agent-only installation image using the es-makeagent command,
you can now specify which operating systems to include in the image. Only the
packages specific to the specified operating systems are included in the image. You can
specify the following versions of the Solaris software:

� Solaris 2.6
� Solaris 7
� Solaris 8
� Solaris 9

The Solaris 9 release supports x86 agents as well as SPARC agents.

SNMP Encryption (Privacy)
Sun Management Center 3.5 Update 1 supports encryption of SNMP communications
between server and agent components of Sun Management Center. SNMP encryption
support uses the CBC-DES symmetric encryption algorithm. Note the following:

� SNMP encryption on both the Sun Management Center server and agent hosts
depends on the SUNWcry package. You must install this package separately.

� SNMP encryption is not supported on Sun Management Center 3.5 and earlier
servers and agents even if SUNWcry is installed.

� SNMP encryption support is automatically configured during agent or server setup
if the SUNWcry package is detected.

� If SNMP encryption is supported by the agent, SNMP encryption can be enabled
on Sun Management Center servers using the es-config script. By using this
script, you can turn on or off the auto-negotiate feature. For details, see “Enabling
SNMP Encryption” on page 26.

Auto-Negotiate Feature
Sun Management Center 3.5 Update 1 servers that support encryption can be set up to
support agents dynamically regardless of whether those agents support encryption.
This feature is called auto-negotiate and can be set to on or off.
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When you set the auto-negotiate feature to off, you ensure that the server always uses
encryption when initiating communication with agents. Environments with strict
security policies might prefer this set up. If you set auto-negotiate to off:

� If the agent supports encryption, the agent understands the encrypted SNMP
messages.

� If the agent does not support encryption, the agent does not understand the
encrypted message. Thus, a timeout occurs and a console message states, “Agent is
not responding.” The timeout is recorded in the agent log.

When you set the auto-negotiate feature to on, the server encrypts its SNMP
communication with an agent only if the agent supports encryption. As a result, the
one of the following events occurs:

� If the agent supports encryption, the agent understands the encrypted SNMP
messages.

� If the agent does not support encryption, the SNMP messages are authenticated only
and not encrypted.

Enabling SNMP Encryption
To find the current state of SNMP encryption, run the es-config command with no
arguments.

� To Enable SNMP Encryption for Server Installations
1. Make sure the SUNWcry package, which contains the

/usr/lib/libcrypt_d.so encryption library, is installed on the system by
typing:

% pkginfo | grep SUNWcry

If the package is installed, the system shows:

application SUNWcry

Note – The SUNWcry package is part of the Solaris Encryption Kit. To obtain the
Solaris Encryption Kit, see your Sun sales representative. For important
information about administering secure systems, see your Solaris system
administration documentation.

2. Type the following command as superuser from the agent host:

# es-config -r

The system detects whether the SUNWcry package is present and automatically
stops all Sun Management Center components. The script then asks for the security
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seed.

3. Type the security seed.

The script asks for the SNMPv1 community string.

4. When asked whether you want to initiate encrypted communication, type y to
initiate encrypted communication or n to decline.

5. When asked whether you want to enable the auto-negotiate feature, type y to
enable or n to decline.

For details on the auto-negotiate feature, see “Auto-Negotiate Feature” on page 25.

Note – If the SUNWcry package is added or is removed after the initial agent setup, use
the es-config script to enable SNMP encryption for the agent.

Multiple Trap Destinations
You can specify multiple secondary trap destinations for Sun Management Center
agents with the es-trapdest command. Secondary trap destinations (zero or more)
receive the same set of traps that are sent to the primary trap destination. Secondary
trap destinations do not receive event traps. By default, all traps sent to secondary
destinations use SNMPv2c with a community of public. The security level for
secondary destinations is noauth.

Using the es-trapdest Command
Secondary trap destinations are managed with the es-trapdest command. You can
use the following options with the command.

TABLE 2–3 es-trapdest Options

To do this Type

List the currently specified
secondary trap destinations

es-trapdest -l

Delete a currently specified
secondary trap destination

es-trapdest -d n

where n is the number of the currently specified
secondary trap destination you want to delete as
displayed by the es-trapdest -l command.
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TABLE 2–3 es-trapdest Options (Continued)
To do this Type

Add a new secondary trap
destination

es-trapdest -a host:port

where host is the name of the destination host and port is
the number of the destination port.

You can also specify the following optional parameters when adding a new secondary
trap destination with the es-trapdest -a command:

-v version Specify SNMP version: SNMPv1, SNMPv2c, or SNMPv2u

-u user Specify the SNMP community or user name

-f filter Specify the trap filter

Trap Filter Specification
Trap filters are specified as a list of criteria, which can be either a series of numerical
OID prefixes or a series of these mnemonic trap names:

� sunmcTraps
� snmpTraps
� coldStart
� warmStart
� linkDown
� linkUp
� authenticationFailure

The trap name sunmcTraps represents the OID prefix for all Sun Management Center
enterprise-specific traps, and the trap name snmpTraps represents the OID prefix for
all the standard traps defined in the SNMP RFCs.

Trap filters can be either positive or negative. A positive filter specifies which traps to
send. A negative filter specifies which traps should not be sent. A negative filter is
defined by specifying NOT as the first criterion.

For example, to forward only standard SNMP traps to the secondary trap destination,
specify the filter as -f "snmpTraps".

To forward all traps except Sun Management Center enterprise-specific traps to the
secondary trap destination, specify the filter as -f "NOT sunmcTraps".

Note – Filter specifications that contain spaces must be enclosed in quotation marks to
prevent misinterpretation by the shell.
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The following command adds machine02:162 as a secondary trap destination that
only receives warmStart and coldStart traps for the Sun Management Center
agent:

es-trapdest -a machine02:162 -f "warmStart coldStart"

Platform Agent Instances
Each instance of a platform agent can have its own set of secondary trap destinations.
To specify secondary trap destinations for a particular instance of a platform agent,
use the -c instance option to the es-trapdest command, where instance is the name
of the platform agent instance. If the -c is not specified as an argument to the
es-trapdest command, the es-trapdest command uses the default value of
agent, which manages the secondary trap destinations for the Sun Management
Center agent component.

Registration Trap Configuration
You can configure the agent to send the registration trap at a custom interval. The
parameter agentRegisterHoldOff controls the initial delay in sending the first
registration trap. By default, the value of this parameter is set to 90 seconds. You can
change this parameter value in the file /var/opt/SUNWsymon/cfg/domain-
config.x. For example, to set the value to 120 in the file, you would type:

agent = {
agentServer = <myHostname>

..
agentRegisterHoldOff = 120

}

The value for this parameter should be between the minimum of 60 seconds and a
maximum of 300 seconds.

If for some reason the initial trap is lost and is not received by the configuration server,
the parameter agentRegisterRetry controls the interval for resending of the agent
registration trap. The parameter has a default value of 300 seconds. If the registration
trap is lost, the agent resends the registration trap at the retry interval until it is
received by the configuration server.

You can change the parameter value from a minimum of 300 seconds to a maximum of
900 seconds. For example, to set the value to 450 in the file, you would type:

agent = {
agentServer = <myHostname>

..
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agentRegisterRetry = 450
}

If you specify a value below the minimum, the system uses the minimum value (300
seconds). If you specify a value higher than the maximum, the system uses the
maximum value (900 seconds). If you do not specify any values, the system uses the
default value of 300 seconds.
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CHAPTER 3

Alternative Methods for Accessing
Java Console Functions

The Sun Management Center 3.5 Update 1 provides the following features. These
enable you to perform management functions using your preferred interface
mechanism (command line or Java-based console):

� All images have associated tooltips
� All fields have an associated Accessible Name
� All screens have an Accessible Description

In addition, the Java Console enables you to perform functions using your keyboard
as well as your mouse.

This chapter describes the following features provided for the Java Console:

� “General Keyboard Navigation” on page 31
� “Keyboard Shortcuts” on page 32
� “Mnemonics” on page 33
� “Images and Graphs” on page 34

General Keyboard Navigation
The Java Console indicates the active window component, called the focus, by either a
blinking cursor or, in the case of buttons or checkboxes, a blue border. On some
screens, a default button might be identified by a black border. To change focus or
activate a button, use the appropriate mechanism:

� To move from field to field within a window, use the Tab key. To move backward
through the fields, use Shift+Tab. If you are in an element such as a field that
allows tabs to be used, then use Ctrl+Tab and Ctrl+Shift+Tab to move through the
fields.
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� Within a group of components, use the arrow keys to move up and down. For
example, once you have tabbed to a particular list-item field, use the arrow keys to
move among the list items.

� To select a button on a window, change focus to the button, then use the spacebar
to activate the button.

� When a default button is identified on a window, press the Return key to activate
that function.

� To navigate through a hierarchical topology, use the up and down arrow keys to
move between levels. Use the left arrow key to expand a level and the right arrow
key to collapse a level.

Keyboard Shortcuts
Keyboard shortcuts are keystroke combinations that activate a menu item from the
keyboard even if the menu for that command is not currently displayed. Keyboard
shortcuts usually consist of a modifier key and a character key, like Ctrl+Z, or a few
special keys, such as F1 and Delete. Unlike mnemonics, keyboard shortcuts do not
display menus. They perform the indicated actions directly.

Table 3–1 provides a list of the standard keyboard shortcuts that the Java Console
supports.

TABLE 3–1 Common Java Console Navigation and Activation Keys

Keyboard Operation Action

Tab Navigates to the next focusable component

Shift+Tab Navigates to the previous focusable
component

Control+Tab Navigates to the next focusable component.
This works even if the component that
previously had focus accepts tabs.

Left Arrow Moves focus left one character or component

Right arrow Moves focus right one character or component

Up arrow Moves focus up one line or component

Down arrow Moves focus down one line or component

Page Up Moves up one pane of information

Page Down Moves down one pane of information
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TABLE 3–1 Common Java Console Navigation and Activation Keys (Continued)
Keyboard Operation Action

Home Moves to the beginning of the data; in a table,
moves to the beginning of a row

End Moves to the end of the data; in a table, moves
to the last cell in a row

Return Activates the default command button

Escape Dismisses a menu or dialog box without
changes; cancels a drag-and-drop operation in
progress

Spacebar Activates the component that has keyboard
focus

Mnemonics
Mnemonics provide another keyboard alternative to the mouse. A mnemonic is an
underlined alphanumeric character in a menu title, menu item, or other interface
component. A mnemonic reminds you how to activate the equivalent command by
simultaneously pressing the Alt key and the character key that corresponds to the
underlined letter or numeral.

When the keyboard focus is not in a text element, you do not always need to use the
Alt key. For example, to choose the Exit command from the File menu, you can hold
down the Alt key and press F to display the File menu, release the Alt key, and then
press X.

Once you have displayed a menu with a keyboard sequence, any subsequent keypress
activates a command only from that menu. For example, you can press Alt+F to
display the File menu and then type A to activate the Save As command, or press
Alt+E to display the Edit menu, and then type A to activate the Select All command.

All menu items in Sun Management Center 3.5 Update 1 have mnemonics. A given
letter might apply to a different function, depending on the menu or the window.
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Images and Graphs
Throughout the Java Console, images indicate screen navigation. These images contain
alternative text that you can display when you move your mouse over the image or
use other similar technology. In addition, some graphs also provide a text-only view of
the data in tabular format. Look for this feature on the graph windows.
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CHAPTER 4

Performance Reporting Manager
(PRM) Enhancements

Sun Management Center 3.5 Update 1 provides a number of enhancements to the
Performance Reporting Manager (PRM). For a complete discussion of the concepts
and terminology discussed in this chapter, see the Sun Management Center 3.5
Performance Reporting Manager User’s Guide.

This chapter discusses the following enhancements to the Performance Reporting
Manager in Sun Management Center 3.5 Update 1:

� “System Uptime Statistics Reports” on page 35
� “Automated CSV Generation” on page 36
� “Additional Graph Options” on page 37
� “Printing From the Java Console” on page 37

System Uptime Statistics Reports
PRM System Uptime Reports compute system uptime and downtime based on the
records entered in the /var/adm/wtmpx file by Solaris commands like shutdown,
init, and so on.

The PRM module on the agent maintains a timestamp updated every five minutes to
account for system downtime caused by power outages or by commands that do not
update the wtmpx file. When a condition does not put an entry into the wtmpx, then
the last known timestamp is used as an approximate downtime record for computing
the system downtime.

The PRM 3.5 Update 1 installation is required on the agent and server machines to
account for system downtime caused by power outages or by commands that do not
update the wtmpx file.

Three new standard reports based on uptime status are provided:
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� Uptime Status Reports — Display the date ranges for which the system was up and
the date ranges for which the system was down for the specified hosts for the
specified date ranges.

� Percentage Uptime Reports — Display the uptime in percentage and the downtime
in percentage for the specified hosts for the specified date range. Percentage
Uptime Reports can be run in two modes: Detailed or Total.

� Percentage Uptime (Detailed) — Detailed Percentage Uptime indicates the
uptime or downtime in percentage for a system for a particular day, week, or
month. Detailed Percentage Uptime indicates multiple values that represent
either daily, weekly, or monthly average percentage uptime or downtime values
depending on the level of data (daily, weekly, or monthly) that is available in
the database for the specified date range.

� Percentage Uptime (Total) — Total Percentage Uptime indicates the total uptime
(or downtime) in percentage for a system for the specified date range. Total
Percentage Uptime indicates a single total percentage uptime value.

� Total Uptime Reports — Display total number of uptime hours and downtime
hours for specified hosts for the specified date range. Total Uptime Reports can be
run in two modes: Detailed or Total.

� Total Uptime (Detailed) — Detailed Total Uptime indicates the number of hours
a system was up or down in a particular day, week, or month. Detailed Total
Uptime indicates multiple values that represent either daily, weekly, or monthly
summed uptime or downtime values in number of hours, depending on the level
of data (daily, weekly, or monthly) that is available in the database for the
specified date range.

� Total Uptime (Total) — Total Uptime indicates the total number of hours a
system was up or down for the specified date range. Total Uptime indicates a
single total uptime value in number of hours.

Note – Uptime Status Reports, Percentage Uptime (Total) Reports, and Total Uptime
(Total) Reports can be generated 90 minutes after the agent is added to the topology of
the server host.

Percentage Uptime (Detailed) and Total Uptime (Detailed) reports can be generated
one day after the server is started.

Automated CSV Generation
Two new report output formats have been added to the Report Request Creation
screen to enable you to automate the generation of CSV (comma separated value)
reports:
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� Comma Separated Text
� Tab Separated Text

Reports in these formats can be used as follows:

� Saved as text files
� Previewed online
� Scheduled to run at predefined times or intervals
� Posted to the web server and viewed there
� Loaded into other applications such as spreadsheet programs

Additional Graph Options
Three new graph formats are provided:

� Area Chart
� Stacked Area Chart
� Stacked Bar Chart

Printing From the Java Console
You can now print report output directly from the Java Console. The Print Screen
menu option prints the current screen or page. For multipage tabular reports, each
page must be printed separately.
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CHAPTER 5

Other Enhancements in Sun
Management Center 3.5 Update 1

Sun Management Center 3.5 Update 1 provides several additional enhancements to
the Sun Management Center 3.5 software:

� “Developer Environment Enhancements” on page 39
� “Production Environment Enhancements” on page 39
� “Add-On Enhancements” on page 40

Developer Environment Enhancements
The Sun Management Center 3.5 Update 1 Developer Environment has been
enhanced.

SMLogin Class Supports Alternate Locales
The SMLogin class now accepts an alternate locale setting as a parameter.

Production Environment Enhancements
The Sun Management Center 3.5 Update 1 Production Environment has been
enhanced.
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Server Host Information
Information about the server host is now available from the Java Console main menu.
Choose View→User Session to obtain the User Login ID and the Server Host name.

Licensing Information
Licensing information about the currently installed version of Sun Management
Center 3.5 Update 1 is available from the Java Console main menu. Choose
Help→About Sun Management Center to view the licensing information.

Add-On Enhancements
The CA Integration TNG Unicenter add-on has been enhanced. You can run the
Unicenter TNG adaptor without starting the graphical user interface.

Starting the Adaptor in Command Line Interface
To start the adaptor in a command line interface, use this syntax:

# SunMC_base_dir/SunMC-TNG/sbin/ea-start [ -h | help] [-f propertyfile \
[ -u username ] ]

Note – The UNIX token (\) indicates the continuation of a command line.

Here is an example of starting the CA Integration TNG Unicenter add-on in the
command line interface :

# /opt/SUNWsymon/SunMC-TNG/sbin/ea-start -f \
/var/opt/SUNWsymon/SunMC-TNG/SunMCToTngAdaptorMain.cfg

Starting the Adapter in Graphical User Interface
To start the adaptor in the graphical user interface, use this syntax:

# SunMC_base_dir/SunMC-TNG/sbin/ea-start [-h help] [-ss serverhost] \
[-sp serverport] [-ts TNG hostname, TNG hostname...] \
[-tp TNG port] [-l log filepath] [-i pollinginterval] \

40 Sun Management Center 3.5 Update 1 Supplement • May 2004



[-u username]

Here is an example of starting the CA Integration TNG Unicenter add-on in the
graphical user interface:

# /opt/SUNWsymon/SunMC-TNG/sbin/ea-start -ss sunmcserv -ts tngserv
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